Before operating the unit, please read this Handbook and “Instruction Manual” thoroughly, and retain it for future reference.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
- For details on “Memory Stick Duo”, see page 104.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the battery pack
- Charge the battery pack (supplied) before using the camera for the first time.
- The battery pack can be charged even if it is not completely discharged. Also, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from your camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
- For details on the usable battery pack, see page 106.

Carl Zeiss lens
This camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast.
The lens for this camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens
- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.

- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
- Images may trail across on the LCD screen in a cold location. This is not a malfunction.
- This camera is equipped with a power zoom lens. Be careful not to bump the lens, and be careful not to apply force to it.

The pictures used in this Handbook
The photographs used as examples of pictures in this Handbook are reproduced images, and are not actual images shot using this camera.

On illustrations
Illustrations used in this Handbook are of the DSC-W55 unless noted otherwise.
Table of contents

Notes on using your camera .................................................................2
Basic techniques for better images .....................................................6
  Focus – Focusing on a subject successfully ............................................. 6
  Exposure – Adjusting the light intensity .................................................. 7
  Color – On the effects of lighting ........................................................... 8
  Quality – On “image quality” and “image size” ......................................... 9
Identifying parts .....................................................................................10
Indicators on the screen ..........................................................................12
Changing the screen display ..................................................................16
Using the internal memory ....................................................................17

Basic Operations

Using the mode dial ..............................................................................18
Shooting images easily (Auto adjustment mode) .......................................19
Shooting still images (Scene selection) ..................................................25
Viewing/deleting images ........................................................................28

Using the menu

Using menu items ..................................................................................30
Menu items .............................................................................................31
Shooting menu .......................................................................................32
  COLOR (Color Mode): Changing the vividness of the image or adding special effects
  (Focus): Changing the focus method
  (Metering Mode): Selecting the metering mode
  WB (White Bal): Adjusting the color tones
  ISO: Selecting a luminous sensitivity
  P.Quality: Selecting the still image quality
  REC Mode: Selecting the continuous shooting method
  (Interval): Selecting the frame interval in the [Multi Burst] mode
  (Flash Level): Adjusting the amount of flash light
  (Contrast): Adjusting the contrast of the image
  (Sharpness): Adjusting the sharpness of the image
  Setup): Changing Setup items
Table of contents

Viewing menu ............................................................................................................. 43
  (Folder): Selecting the folder for viewing images
  (Protect): Preventing accidental erasure
  DPOF: Adding a Print order mark
  (Print): Printing images using a printer
  (Slide): Playing back a series of images
  (Resize): Changing the image size of a recorded image
  (Rotate): Rotating a still image
  (Divide): Cutting movies
  (Setup): Changing Setup items
  Trimming: Recording an enlarged image

Using the Setup screen

Using Setup items .................................................................................................. 50
  Camera .................................................................................................................. 51
    AF Mode ..............................................................................................................
    Digital Zoom ....................................................................................................
    Function Guide ................................................................................................
  Internal Memory Tool ...........................................................................................
    Format ................................................................................................................
  Memory Stick Tool .................................................................................................. 55
    Format ................................................................................................................
    Create REC. Folder ............................................................................................
    Change REC. Folder .........................................................................................
    Copy ...................................................................................................................
  Setup 1 ..................................................................................................................
    LCD Backlight (DSC-W55 only) ........................................................................
    Beep ..................................................................................................................
    Language ............................................................................................................
    Initialize ...........................................................................................................
  Setup 2 ..................................................................................................................
    File Number .....................................................................................................
    USB Connect ....................................................................................................
    Video Out .........................................................................................................
    Clock Set ..........................................................................................................
# Table of contents

## Using your computer

- Enjoying your Windows computer ........................................................... 63
- Installing the software (supplied) .............................................................. 65
- Copying images to your computer ........................................................... 66
- Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”) ................................................................. 73
- Using the “Picture Motion Browser” (supplied) ........................................ 74
- Using your Macintosh computer .............................................................. 80

## Printing still images

- How to print still images ........................................................................ 82
- Printing images directly using a PictBridge compliant printer ................. 83
- Printing at a shop ................................................................................... 87

## Troubleshooting

- Troubleshooting .................................................................................... 89
- Warning indicators and messages ......................................................... 100

## Others

- To use your camera abroad — Power sources ........................................ 103
- On the “Memory Stick” .......................................................................... 104
- On the battery pack ............................................................................... 106
- On the battery charger .......................................................................... 107

## Index

- Index ...................................................................................................... 108
Basic techniques for better images

Focus

Focus Exposure Color Quality

This section describes the basics so you can enjoy your camera. It tells you how to use various camera functions such as the mode dial (page 18), the menus (page 30), and so on.

Focus

Focusing on a subject successfully

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

Press the shutter button fully down suddenly.

Press the shutter button halfway down.

AE/AF lock indicator flashing ➔ lit/beeps

Then press the shutter button fully down.

To shoot a still image difficult to focus on → [Focus] (page 33)
If the image looks blurred even after focusing, it may be because of camera shake. → See “Hints for preventing blur” (as follows).

Hints for preventing blur

Hold the camera steady, keeping your arms at your side. It is recommended to lean against a tree or a building nearby to steady yourself. Shooting with a 2-second delay self-timer or using a tripod is also effective. Use the flash when you shoot under a low light condition.
Basic techniques for better images

**Exposure**  
**Adjusting the light intensity**

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

**Shutter speed** = Length of time the camera receives light

**Aperture** = Size of the opening allowing light to pass through

**ISO sensitivity (Recommended Exposure Index)** = Recording sensitivity

**Overexposure**  
= too much light  
Whitish image  
The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**Correct exposure**

**Underexposure**  
= too little light  
Darker image  

**Adjusting the ISO sensitivity (Recommended Exposure Index)**

ISO sensitivity is measurement, estimating how much light an image pickup device receives. Even when the exposure is the same, images differ depending on the ISO sensitivity. To adjust the ISO sensitivity, see page 37.

**High ISO sensitivity**
Records a bright image even when shooting in a dark location. However, the image tends to become noisy.

**Low ISO sensitivity**
Records a smoother image. However, when the exposure is insufficient, the image may become darker.
Basic techniques for better images

Color

On the effects of lighting

The apparent color of the subject is affected by the lighting conditions.

Example: The color of an image affected by light sources

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Blue-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode. However, you can adjust color tones manually with [White Bal] (page 36).
Basic techniques for better images

Quality

On “image quality” and “image size”

A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

1. Image size: 7M
   3072 pixels × 2304 pixels = 7,077,888 pixels

2. Image size: VGA
   640 pixels × 480 pixels = 307,200 pixels

Selecting the image size for use (page 24)

Many pixels (Fine image quality and large file size)

Example: Printing in up to A3 size

Few pixels (Rough image quality but small file size)

Example: An attached image to be sent by e-mail

Selecting the image quality (compression ratio) in combination (page 38)

You can select the compression ratio when digital images are saved. When you select a high compression ratio, the image lacks the fineness of detail, but has a smaller file size.
Identifying parts

See the pages in parentheses for details of operation.

1 Shutter button (19)
2 For shooting: Zoom (W/T) lever (20)
   For viewing: / (Playback zoom) lever/ (Index) lever (28, 29)
3 Finder window
4 Lens
5 POWER button/POWER lamp
6 Microphone
7 Flash (21)
8 Self-timer lamp (22)/AF illuminator (53)

1 AE/AF lock lamp/Self-timer lamp (green) (22)
2 Flash charging lamp/Record lamp (orange)
3 Speaker
4 Finder
5 LCD screen (16)
Identifying parts

6 DISP (Screen display switch) button (16)
   - Press DISP (Screen display switch) button longer to select the brightness of the LCD backlight (DSC-W55 only).

7 MENU button (30)
   - Press MENU longer to display the (Setup) screen.

8 [ ] (Playback) button (28)

9 Hook for wrist strap

10 Mode dial (18)

11 Control button
   Menu on: ▲/▼/◄/►/● (30)
   Menu off: ◆/●/□/☆ (21-23)

12 [ ]/ [ ] (Image Size/Delete) button (24, 28)

13 Tripod receptacle (bottom)
   - Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and may damage the camera.
   - After use, remove the camera from the tripod.

14 Battery/“Memory Stick Duo” cover

15 Access lamp

16 “Memory Stick Duo” slot

17 Battery insertion slot

18 Battery eject lever

19 Multi connector (bottom) (DSC-W55)
   - The multi connector is used in the following situations:
     - USB connection with a computer
     - AV connection with a TV
     - PictBridge connection with a printer

20 DC IN jack (DSC-W35)
   When using an AC-LS5K AC Adaptor (not supplied)
   For details, refer to the operation manual supplied with the AC adaptor.

21 DC IN jack cover (DSC-W35)

22 A/V OUT jack (DSC-W35)

23 Jack cover (DSC-W35)

24 [USB] jack (DSC-W35)
Indicators on the screen

See the pages in parentheses for details of operation.

When shooting still images

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>📀</td>
<td>Battery remaining</td>
</tr>
<tr>
<td>•</td>
<td>AE/AF lock (19)</td>
</tr>
<tr>
<td>📀</td>
<td>Recording mode (18, 39)</td>
</tr>
<tr>
<td>$WB $WB</td>
<td>White balance (36)</td>
</tr>
<tr>
<td>STBY</td>
<td>Standby/Recording a movie</td>
</tr>
<tr>
<td>REC</td>
<td>Mode dial (Scene Selection) (18)</td>
</tr>
<tr>
<td>ISO</td>
<td>Mode dial (Program Auto) (18)</td>
</tr>
<tr>
<td>📸</td>
<td>Camera mode (19)</td>
</tr>
<tr>
<td>⚡️</td>
<td>Flash mode (21)</td>
</tr>
<tr>
<td>⚡️️</td>
<td>Flash charging</td>
</tr>
</tbody>
</table>

When shooting movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>✈️</td>
<td>Macro (21)</td>
</tr>
<tr>
<td>S AF M AF</td>
<td>AF mode (51)</td>
</tr>
<tr>
<td>✈️️</td>
<td>AF range finder frame indicator (33)</td>
</tr>
<tr>
<td>1.0m</td>
<td>Focus preset distance (33)</td>
</tr>
<tr>
<td>⦽ ⦽ ⦽</td>
<td>Exposure value scale bar (23)</td>
</tr>
</tbody>
</table>

• The display is changed, depending on the position of the mode dial (shown left).

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>⦽ ⦽ ⦽</td>
<td>Exposure value guide (23)</td>
</tr>
</tbody>
</table>

1.3 | Zoom scaling (20, 51)

庄村 reduction (52)

Sharpness (42)

Contrast (42)

AF illuminator (53)

Metering mode (35)

RICH NATURAL SEPIA B&W

Color mode (32)
# Indicators on the screen

## Display | Indication
---|---
[Image size (24)] | Image size (24)
- 7M  | Display
- 5M | 3:2
- 3M | 16:9
- VGA | 16:9
- 3M | 1M
- 2M | 1M
- 1M | 1M
- 5M | 5M
- 7M | 7M
- FINE STD | Image quality (38)
- 3:2 | FINE
- 16:9 | STD
- 7M | 7M
- 5M | 5M
- 3M | 3M
- 2M | 2M
- 1M | 1M
- VGA | VGA
- [Image size (24)] | AF range finder frame (33)

## Display | Indication
---|---
[Remaining internal memory capacity] | Recording folder (55)
- 00:00:00 | Remains internal memory capacity
- [00:28:25] | Remaining internal memory capacity
- 1/30” | Multi Burst interval (41)
- 400 | Remaining number of recordable images
- C:32:00 | Self-timer (22)
- Iso400 | ISO number (37)

## Display | Indication
---|---
[Image quality (38)] | Image quality (38)
- FINE | FINE
- STD | STD

## Display | Indication
---|---
[Remaining “Memory Stick” capacity] | Remaining “Memory Stick” capacity
- 00:00:00 | Recording time [maximum recordable time]
- [00:28:25] | Recording time [maximum recordable time]
- 1/30” | Multi Burst interval (41)
- 400 | Remaining number of recordable images
- 125 | Shutter speed
- F3.5 | Aperture value
- +2.0EV | Exposure Value (23)

## Display | Indication
---|---
[Self-timer (22)] | Self-timer (22)
- C:32:00 | Self-diagnosis display (100)
- Iso400 | ISO number (37)

## Display | Indication
---|---
[Self-diagnosis display (100)] | Self-diagnosis display (100)
- F3.5 | Aperture value
- +2.0EV | Exposure Value (23)

## Display | Indication
---|---
[AF range finder frame (33)] | AF range finder frame (33)

## Display | Indication
---|---
[Histogram (16, 23)] | Histogram (16, 23)

## Display | Indication
---|---
[NR slow shutter] | NR slow shutter
- When the shutter speed drops below a certain speed in low light conditions, the NR (Noise Reduction) slow shutter function activates automatically to reduce the picture noise.

## Display | Indication
---|---
[Spot metering cross hair (35)] | Spot metering cross hair (35)

## Display | Indication
---|---
[Exposure Value (23)] | Exposure Value (23)
- 125 | Shutter speed
- F3.5 | Aperture value
- +2.0EV | Exposure Value (23)

## Display | Indication
---|---
[Menu (30)] | Menu (30)
- (not displayed on the screen on the previous page) | Menu (30)
Indicators on the screen

When playing back still images

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Battery remaining" /></td>
<td>Battery remaining</td>
</tr>
<tr>
<td><img src="image" alt="Recording mode" /></td>
<td>Recording mode (18, 39)</td>
</tr>
<tr>
<td><img src="image" alt="Image size" /></td>
<td>Image size (24)</td>
</tr>
<tr>
<td><img src="image" alt="Playback mode" /></td>
<td>Playback mode (28)</td>
</tr>
<tr>
<td><img src="image" alt="Protect" /></td>
<td>Protect (43)</td>
</tr>
<tr>
<td><img src="image" alt="Print order (DPOF) mark" /></td>
<td>Print order (DPOF) mark (87)</td>
</tr>
<tr>
<td><img src="image" alt="Change folder" /></td>
<td>Change folder (43)</td>
</tr>
<tr>
<td><img src="image" alt="Zoom scaling" /></td>
<td>Zoom scaling (28)</td>
</tr>
<tr>
<td><img src="image" alt="Step" /></td>
<td>Frame by frame playback (39)</td>
</tr>
<tr>
<td><img src="image" alt="Playback" /></td>
<td>Playback (28)</td>
</tr>
<tr>
<td><img src="image" alt="Volume" /></td>
<td>Volume (28)</td>
</tr>
</tbody>
</table>

When playing back movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Battery remaining" /></td>
<td>Battery remaining</td>
</tr>
<tr>
<td><img src="image" alt="Recording mode" /></td>
<td>Recording mode (18, 39)</td>
</tr>
<tr>
<td><img src="image" alt="Image size" /></td>
<td>Image size (24)</td>
</tr>
<tr>
<td><img src="image" alt="Playback mode" /></td>
<td>Playback mode (28)</td>
</tr>
<tr>
<td><img src="image" alt="Protect" /></td>
<td>Protect (43)</td>
</tr>
<tr>
<td><img src="image" alt="Print order (DPOF) mark" /></td>
<td>Print order (DPOF) mark (87)</td>
</tr>
<tr>
<td><img src="image" alt="Change folder" /></td>
<td>Change folder (43)</td>
</tr>
<tr>
<td><img src="image" alt="Zoom scaling" /></td>
<td>Zoom scaling (28)</td>
</tr>
<tr>
<td><img src="image" alt="Step" /></td>
<td>Frame by frame playback (39)</td>
</tr>
<tr>
<td><img src="image" alt="Playback" /></td>
<td>Playback (28)</td>
</tr>
<tr>
<td><img src="image" alt="Volume" /></td>
<td>Volume (28)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>101-0012</td>
<td>Folder-file number (43)</td>
</tr>
<tr>
<td></td>
<td>Playback bar</td>
</tr>
</tbody>
</table>
Indicators on the screen

3

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge connecting (84)</td>
<td></td>
</tr>
</tbody>
</table>
| Recording folder (55)  
  - This does not appear when using internal memory. |
| Playback folder (43)  
  - This does not appear when using internal memory. |
| Remaining internal memory capacity |
| Remaining “Memory Stick” capacity |
| 8/8 12/12  
  - Image number/Number of images recorded in selected folder |
| C:32:00  
  - Self-diagnosis display (100) |
| 00:00:12  
  - Counter |

4

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
</table>
| PictBridge connecting (86)  
  - Do not disconnect the cable for multi-use terminal (DSC-W55)/USB cable (DSC-W35), while the icon is displayed. |
| +2.0EV  
  - Exposure Value (23) |
| ISO400  
  - ISO number (37) |
| Metering mode (35) |
| Flash |
| White balance (36) |
| 500  
  - Shutter speed |
| F3.5  
  - Aperture value |
| Playback image |

5

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
</table>
| Histogram (16, 23)  
  -  appears when histogram display is disabled. |
| 2007 1 1 9:30 AM  
  - Recorded date/time of the playback image |
| Menu (30) |
| PAUSE  
  - Playing back Multi Burst images in series (39) |
| PLAY  
  - Select images |
| BACK/NEXT |
| VOLUME  
  - Adjust volume |
Changing the screen display

Each time you press the DISP (Screen display switch) button, the display changes as follows.

- **Press DISP (Screen display switch) button longer to select the brightness of the LCD backlight (DSC-W55 only).**
- **When you set the histogram display to on, image information is displayed during playback.**
- **The histogram does not appear in the following situations:**
  - While shooting
  - When the menu is displayed.
  - When recording movies
  - During playback
  - When the menu is displayed.
  - In index mode
  - When you are using playback zoom.
  - When you are rotating still images.
  - During playback of movies
- **During image playback, you cannot turn the LCD screen off.**
- **A large difference in the histogram displayed when shooting and during playback may occur when:**
  - The flash strobes.
  - The shutter speed is slow or high.
- **The histogram may not appear for images recorded using other cameras.**
- **When you set the LCD screen to off, the digital zoom does not function and [AF Mode] is set to [Single] (page 51). When you select [Flash mode]/[Self-timer]/[Macro], the image is displayed for about two seconds.**
Using the internal memory

The camera has approximately 56 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

- Movies with the image size set to [640(Fine)] cannot be recorded using the internal memory.

**When a “Memory Stick Duo” is inserted**

- **[Recording]**: Images are recorded on the “Memory Stick Duo”.
- **[Playback]**: Images on the “Memory Stick Duo” are played back.
- **[Menu, Setup, etc.]**: Various functions can be performed on images on the “Memory Stick Duo”.

**When there is no “Memory Stick Duo” inserted**

- **[Recording]**: Images are recorded using the internal memory.
- **[Playback]**: Images stored in the internal memory are played back.
- **[Menu, Setup, etc.]**: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without error using one of the following methods.

**To copy (back up) data on a “Memory Stick Duo”**

Prepare a “Memory Stick Duo” with a capacity of 64 MB or more, then perform the procedure explained in [Copy] (page 50, 57).

**To copy (back up) data on a hard disk of your computer**

Perform the procedure on pages 66 to 69 without a “Memory Stick Duo” inserted in the camera.

- You cannot copy image data on a “Memory Stick Duo” to the internal memory.
- You can copy data stored in the internal memory to a computer via a USB connection between a computer and your camera, but you cannot copy data on a computer to the internal memory.
Using the mode dial

Set the mode dial to the desired function.

Still image shooting modes

ائق: Auto Adjustment mode
Allows easy shooting with the settings adjusted automatically. → page 19

P: Program Auto mode
Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu.
(For details on the functions available → page 31)

Still image shooting modes

シーン: Scene Selection mode
Allows you to shoot with preset settings according to the scene. → page 25

On Function Guide
When [Function Guide] is set to [On], the descriptions of functions are displayed as you operate the camera.
The default setting is [On]. Select [Off] if you do not want the function guide to appear (page 52).
Shooting images easily (Auto adjustment mode)

1 Select a mode with the mode dial.
   Still image (auto adjustment mode): Select 📷.
   Movie: Select 📹.

2 Hold the camera steady, keeping your arm at your side.
   Position the subject in the center of the focus frame.
   Do not cover the microphone with your finger.

3 Shoot with the shutter button.
   Still image:
   ① Press and hold the shutter button halfway down to focus.
      The ⬤ (AE/AF lock) indicator (green) flashes, a beep sounds, the indicator stops flashing and remains lit.
   ② Press the shutter button fully down.
      The shutter sounds.

AE/AF lock indicator
Shooting images easily (Auto adjustment mode)

Movie:
Press the shutter button fully down.
To stop recording, press the shutter button fully down again.

If you shoot a still image of a subject that is difficult to focus on

• The shortest shooting distance is approx. 50 cm (19 3/4 inches). Shoot in the close-up (Macro) mode (page 21) when you shoot a subject closer than the shooting distance.
• When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flashing slowly and the beep does not sound. Recompose the shot and focus again.

Subjects difficult to focus on are:
– Distant from the camera and dark
– The contrast between the subject and its background is poor.
– Seen through glass
– Moving fast
– Reflective light or with a lustrous finish
– Flashing
– Backlit

📚🔍 Using the zoom
Slide the zoom lever.
• When the zoom scale exceeds 3x, the camera uses the Digital Zoom function.
  For details on the [Digital Zoom] settings and the image quality, see page 51.
• You cannot change the zoom scale while shooting a movie.
**Flash (Selecting a flash mode for still images)**

Press ▲ (_flash_) on the control button repeatedly until the desired mode is selected.

(No indicator): Flash Auto

- Strobes when there is insufficient light or backlight (default setting)

فاق: Flash forced on

فاق: Slow synchro (Flash forced on)

- The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light.

فاق: Flash forced off

- The flash strobes twice. The first time is to adjust the light quantity.
- While charging the flash,  is displayed.

**Macro (Shooting close-up)**

Press ▶ (macro_) on the control button.

To cancel, press ▶ again.

(No indicator): Macro Off

فاق: Macro On (W side: Approx. 2 cm or farther (13/16 inches or farther), T side: Approx. 30 cm or farther (11 7/8 inches or farther))

Macro

- Setting the zoom all the way to the W side is recommended.
- The in-focus range becomes narrow, and the complete subject may not entirely be in focus.
- The Auto Focus speed drops.
Shooting images easily (Auto adjustment mode)

Using the self-timer

Press ▼ ( ) on the control button repeatedly until the desired mode is selected.

(No indicator): Not using the self-timer

: Setting the 10-second delay self-timer

: Setting the 2-second delay self-timer

Press the shutter button, the self-timer lamp flashes, and a beep sounds until the shutter operates.

To cancel, press ▼ again.

- Use the 2-second delay self-timer to prevent blur of an image made by the shaking of the camera when pressing the shutter button.
 shooting images easily (auto adjustment mode)

! ev (adjusting the exposure manually)
press \( \downarrow \) ( ) on the control button, then press ▲ (brighter)/▼ (darker) to adjust. to turn off the bar displayed, press the \( \uparrow \) button again.

- for details on the exposure, see page 7.
- the compensation value can be set in 1/3ev increments.
- if a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.

• adjusting ev (exposure value) by displaying a histogram

- the histogram also appears when playing back a single still image; however exposure cannot be adjusted.
Shooting images easily (Auto adjustment mode)

To change the image size

Press [ ] (Image Size), and then press ▲/▼ to select the size.
For details on the image size, see page 9.
The default settings are marked with √.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Guidelines</th>
<th>No. of images</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>√ 7M (3072×2304)</td>
<td>Up to A3/11×17&quot; print</td>
<td>Less</td>
<td>Fine</td>
</tr>
<tr>
<td>3:21) (3072×2048)</td>
<td>Match 3:2 Aspect Ratio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5M (2592×1944)</td>
<td>Up to A4/8×10&quot; print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>Up to 13×18cm/5×7&quot; print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2M (1632×1224)</td>
<td>Up to 10×15cm/4×6&quot; print</td>
<td>More</td>
<td>Rough</td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>For E-mail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:92) (1920×1080)</td>
<td>Display On 16:9 HDTV</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Images are recorded in 3:2 aspect ratio, same as photograph printing paper or postcards, etc.
2) Both edges of the image may be cut off when printing (page 97).

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>640(Fine) (640×480)</td>
<td>Approx. 30</td>
<td>Display on TV (high quality)</td>
</tr>
<tr>
<td>√ 640(Standard) (640×480)</td>
<td>Approx. 17</td>
<td>Display on TV (standard)</td>
</tr>
<tr>
<td>160 (160×112)</td>
<td>Approx. 8</td>
<td>For E-mail</td>
</tr>
</tbody>
</table>

- The larger the image size, the higher the image quality.
- The more frames per second you played back, the smoother playback can be.
Shooting still images (Scene selection)

1. Select the desired mode of Scene Selection (®, @, †, ropolis, art, 3D) with the mode dial.
   - For details on modes, see the next page.

2. Shoot with the shutter button.

To cancel the Scene Selection
Set the mode dial to other than the mode of Scene Selection.
Scene Selection modes

The following modes are predetermined to match the scene conditions.

- **High Sensitivity**: Allows you to shoot images without a flash under low light conditions, reducing blur.

- **Twilight**: Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.

- **Landscape**: Focuses only on a distant subject to shoot landscapes, etc.

- **Soft Snap**: Allows you to shoot skin colors in brighter and warmer tones for more beautiful pictures. In addition, the soft focus effect creates a gentle atmosphere for portraits of people, flowers, etc.

- **Twilight Portrait**: Suitable for shooting portraits in dark places. Allows you to shoot sharp images of people in dark places without losing the dark atmosphere of the surroundings.

- **Beach**: When shooting seaside or lakeside scenes, the blue of the water is clearly recorded.

- **Snow**: When shooting snowy scenes or other places where the whole screen appears white, use this mode to prevent sunken colors and record clear images.

*The shutter speed is slower in ☼ (Twilight mode) and ☀️ (Twilight Portrait mode), so using a tripod is recommended.*
Shooting still images (Scene selection)

Functions that cannot be combined with Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. Some functions are not available, depending on the Scene Selection mode. When you press the button to select functions that cannot be combined with Scene Selection, a beep sounds.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Macro</th>
<th>Flash</th>
<th>AF range finder</th>
<th>Focus preset</th>
<th>White Balance</th>
<th>Burst/ Multi Burst</th>
<th>Flash level</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>✓</td>
<td>〇</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>—</td>
<td>✓</td>
<td>〇</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>—</td>
<td>✓</td>
<td>〇</td>
<td>✓</td>
<td>∞</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>—</td>
<td>✓</td>
<td>〇/〇</td>
<td>✓</td>
<td>∞</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>—</td>
<td>✓</td>
<td>〇/〇</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
**Viewing/deleting images**

1. **Press (Playback) button.**
   
   If you press (Playback) button when the camera is powered off, the camera is turned on in the playback mode. If you press again, switches to recording mode.

2. **Select an image with \(\downarrow/\uparrow\) on the control button.**
   
   **Movie:**
   
   - Press \(\bullet\) to play back a movie. (Press \(\bullet\) again to stop playback.)
   - Press \(\uparrow\) to fast forward, press \(\downarrow\) to rewind. (Press \(\bullet\) to return to normal playback.)
   - Press \(\Delta/\nabla\) to adjust the volume.
   - Movies with the image size [160] are displayed a size smaller.

3. **(Delete) button**

4. **(Index)/(Playback zoom) lever**

5. **(Playback zoom) lever**

6. **(Playback) button**

---

1. **Press (Playback) button.**

2. **Select an image with \(\downarrow/\uparrow\) on the control button.**

   **Movie:**
   
   - Press \(\bullet\) to play back a movie. (Press \(\bullet\) again to stop playback.)
   - Press \(\uparrow\) to fast forward, press \(\downarrow\) to rewind. (Press \(\bullet\) to return to normal playback.)
   - Press \(\Delta/\nabla\) to adjust the volume.
   - Movies with the image size [160] are displayed a size smaller.

3. **To delete images**
   
   1. Display the image you want to delete and press \(\blacklozenge/\square\) (Delete).
   2. Select [Delete] with \(\downarrow\), then press \(\bullet\).

4. **To cancel the deletion**
   
   Select [Exit], then press \(\bullet\).

5. **To view an enlarged image (playback zoom)**

   Slide \(\blacklozenge\) lever while displaying a still image.

   To undo the zoom, slide \(\blacklozenge\) lever.

   Adjust the portion: \(\Delta/\nabla/\leftarrow/\rightarrow\)

   Cancel playback zoom: \(\bullet\)

   - To store enlarged images: [Trimming] (page 49)
Viewing/deleting images

Viewing an index screen

Slide  (Index) lever and select an image with ▲/▼/◀/▶. To display the next (previous) index screen, press ◀/▶.
To return to the single-image screen, press ●.

To delete images in index mode

1. While an index screen is displayed, press  (Delete) and select [Select] with ▲/▼ on the control button, then press ●.
2. Select the image you want to delete with ▲/▼/◀/▶, then press ● to display the  (Delete) indicator on the selected image.

3. Press  (Delete).
4. Select [OK] with ▶, then press ●.
   - To delete all the images in the folder, select [All In This Folder] with ▲/▼ in step 1 instead of [Select], then press ●.
Using menu items

1 Recording: Turn on the camera, then set the mode dial.
Playback: Press ➤ (Playback) button.

Different items are available depending on the position of the mode dial and Recording/Playback mode.

2 Press MENU to display the menu.

3 Select the desired menu item with ◀/▶ on the control button.
   • If the desired item is invisible, keep pressing ◀/▶ until the item appears on the screen.
   • Press ● after selecting an item in the Playback mode.

4 Select a setting with △/▼.
   The setting you select is zoomed and set.

5 Press MENU to turn off the menu.

   • If there is an item that is not displayed, an △/▼ mark appears on the edges of the location where menu items usually appear. To display an item that is not displayed, select the mark with the control button.
   • You cannot set items that are not available to select.
Menu items

Menu for shooting (page 32)

The menu items available vary depending on the mode dial position and settings. Only the available items are displayed on the screen.

<table>
<thead>
<tr>
<th>Mode dial position:</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR (Color Mode)</td>
<td>—</td>
<td>✔</td>
</tr>
<tr>
<td>(Focus)</td>
<td>—</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>(Metering Mode)</td>
<td>—</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>WB (White Bal)</td>
<td>—</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>✔ ✔ —</td>
</tr>
<tr>
<td>(P.Quality)</td>
<td>—</td>
<td>✔ ✔ —</td>
</tr>
<tr>
<td>Mode (REC Mode)</td>
<td>✔ ✔ ✔</td>
<td>—</td>
</tr>
<tr>
<td>(Interval)</td>
<td>—</td>
<td>✔ ✔ —</td>
</tr>
<tr>
<td>(Flash Level)</td>
<td>—</td>
<td>✔ ✔ —</td>
</tr>
<tr>
<td>(Contrast)</td>
<td>—</td>
<td>✔ ✔ —</td>
</tr>
<tr>
<td>(Sharpness)</td>
<td>—</td>
<td>✔ — —</td>
</tr>
<tr>
<td>(Setup)</td>
<td>✔ ✔ ✔</td>
<td>✔ ✔</td>
</tr>
</tbody>
</table>

Menu for viewing (page 43)

- (Folder)            (Protect)
- (Print)
- (Slide)              (Resize)
- (Rotate)             (Divide)
- (Setup)              Trimming*

* The operation is limited according to the Scene mode (page 27).
**Available only for playback zoom.

In this “Cyber-shot Handbook”, the available mode dial setting is shown as follows.
Shooting menu

The default settings are marked with ✅.

**COLOR (Color Mode): Changing the vividness of the image or adding special effects**

You can change the brightness of the image, accompanied by effects.

<table>
<thead>
<tr>
<th>Color Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W (B &amp; W)</td>
<td>Sets the image to monochromatic color.</td>
</tr>
<tr>
<td>Sepia (SEPIA)</td>
<td>Sets the image to sepia color.</td>
</tr>
<tr>
<td>Natural (NATURAL)</td>
<td>Sets the image to quiet color.</td>
</tr>
<tr>
<td>Rich (RICH)</td>
<td>Sets the image to bright color.</td>
</tr>
<tr>
<td>✅ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can select only [Normal], [B&W] or [Sepia] when shooting movies.
- When [Multi Burst] is selected, the color mode is set to [Normal].
You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

<table>
<thead>
<tr>
<th>(Focus): Changing the focus method</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>∞ (unlimited distance)</strong></td>
<td>Focuses on the subject using a previously set distance to the subject. (Focus preset)</td>
</tr>
<tr>
<td>7.0m</td>
<td>• When shooting a subject through a net or through window glass, it is difficult to get the proper focus in auto focus mode. In these cases, use of [Focus] is convenient.</td>
</tr>
<tr>
<td>3.0m</td>
<td></td>
</tr>
<tr>
<td>1.0m</td>
<td></td>
</tr>
<tr>
<td>0.5m</td>
<td></td>
</tr>
</tbody>
</table>

- **Center AF** (Center AF)
  - Focuses on a subject in the center of the finder frame automatically.
  - Using this with the AF lock function lets you shoot in the desired image composition.

- **Multi AF** (Multipoint AF)
  - Focuses on a subject in all ranges of the finder frame automatically.
  - This mode is useful when the subject is not in the center of the frame.

- **AF** stands for Auto Focus.
- Distance setting information in [Focus] is approximate. If you point the lens up or down, the error increases.
- [Multi AF] is recommended for shooting movies.
- When you use Digital Zoom or AF Illuminator, priority AF movement is given to subjects in or near the center of the frame. In this case the  or  indicator flashes and the AF range finder frame is not displayed.
- Some options are not available depending on the Scene mode (page 27).
If the subject is out of focus
When shooting with the subject at the edge of the frame (or the screen) or when using [Center AF], the camera may not focus on a subject at the edge of the frame.

In such cases, do as follows.

① Recompose the shot so that the subject is centered in the AF range finder, and press the shutter button halfway down to focus on the subject (AF lock).

As long as you do not press the shutter button fully down, you can retry the procedure as many times as you want.

② When the AE/AF lock indicator stops flashing and remains on, return to the fully composed shot, and press the shutter button fully down.
Selects the metering mode that sets which part of the subject to measure to determine the exposure.

| Spot (Spot metering) (Spot metering) | Measures only a part of the subject.  
• This function is useful when the subject is backlit or when there is strong contrast between the subject and the background. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Center (Center-weighted metering) (Center-weighted metering)</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there.</td>
</tr>
<tr>
<td>✔ Multi (Multi-pattern metering)</td>
<td>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure.</td>
</tr>
</tbody>
</table>

- For details on the exposure, see page 7.
- When using spot metering or center-weighted metering, setting [Focus] (Focus) to [Center AF] is recommended to focus on the metering position (page 33).
Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash (WB)</td>
<td>Adjusts for the flash conditions. • You cannot select this item when shooting movies.</td>
</tr>
<tr>
<td>Incandescent ( brightness)</td>
<td>Adjusts for incandescent lighting or bright lighting, such as typically found in photography studios.</td>
</tr>
<tr>
<td>Fluorescent ( )</td>
<td>Adjusts for fluorescent lighting.</td>
</tr>
<tr>
<td>Cloudy ( )</td>
<td>Adjusts for a cloudy sky or in the shade.</td>
</tr>
</tbody>
</table>
Using the menu

Shooting menu

For details on the operation page 30

<table>
<thead>
<tr>
<th>Daylight</th>
<th>Adjust for outdoors on a clear day, evening scenes, night scenes, neon signs, or fireworks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Auto</td>
<td>Adjusts the White Balance automatically.</td>
</tr>
</tbody>
</table>

• For details on the white balance, see page 8.
• Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent] ( ).
• Except in [Flash] ( ) modes, [WB] is set to [Auto] when the flash strobes.
• Some options are not available depending on the Scene mode (page 27).

ISO: Selecting a luminous sensitivity

Small number

Large number

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.

<table>
<thead>
<tr>
<th>1000</th>
<th>Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.</th>
</tr>
</thead>
<tbody>
<tr>
<td>800</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
<tr>
<td>☑ Auto</td>
<td></td>
</tr>
</tbody>
</table>

• For details on the ISO sensitivity, see page 7.
• Note that the image tends to become noisier as the ISO sensitivity number increases.
• [ISO] is set to [Auto] in the Scene mode.
Selects the still image quality.

<table>
<thead>
<tr>
<th>✔ Fine (FINE)</th>
<th>Records with high quality (low compression).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>![Image]</td>
</tr>
<tr>
<td></td>
<td>• When the mode dial is 📷, the quality of a still image is [Fine].</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard (STD)</th>
<th>Records with standard quality (high compression).</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td></td>
</tr>
</tbody>
</table>
**Shooting menu**

For details on the operation [page 30]

---

### Mode (REC Mode): Selecting the continuous shooting method

Selects whether the camera performs continuous shooting or not when you press the shutter button.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| Multi Burst (Multi Burst) | Records 16 frames in succession as a still image file when you press the shutter button.  
  - The image size of images shot in the Multi Burst mode is 1M.  
  - This is convenient for checking your form in sports, for example.  
  - You can select the Multi Burst shutter interval in [Interval] mode (page 41).  
  - The images are displayed in sequence on the camera screen.  
  - The image is printed as a single image with 16 frames.  
  - The flash is set to (Flash forced off). |
| Burst (Burst) | Records the maximum number of images in succession (refer to the following table) when you press and hold down the shutter button.  
  - When “Recording” disappears, you can shoot the next image.  
  - The flash is set to (Flash forced off). |
| Normal    | Does not shoot continuously.                                                                   |

---

**On the [Multi Burst]**

- You can successively play back images shot in the Multi Burst mode using the following procedures:
  - To pause/resume: Press on the control button.
  - To play back frame-by-frame: Press in pause mode. Press to resume playback in series.
- You cannot use the following functions in the Multi Burst mode:
  - Smart zoom
  - Dividing a series of images shot in the Multi Burst mode
  - Extracting or deleting a frame in a series of images shot in the Multi Burst mode
  - Setting the frame interval to a mode other than [1/30] when the mode dial is set to [ ]
- When playing back a series of images shot in the Multi Burst mode using a computer or a camera not equipped with the Multi Burst function, the image is displayed as a single image with 16 frames.
Shooting menu

For details on the operation page 30

• You may not be able to shoot images in the Multi Burst mode depending on the Scene mode (page 27).

On the [Burst]
• When recording with the self timer, a series of a maximum of five images is recorded.
• The recording interval is approximately 0.9 second.
• When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
• You may not be able to shoot images in the Burst mode depending on the Scene mode (page 27).

The maximum number of continuous shots
(Units: images)

<table>
<thead>
<tr>
<th>Size</th>
<th>Quality</th>
<th>Fine</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>7M</td>
<td></td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>3:2</td>
<td></td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>5M</td>
<td></td>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>3M</td>
<td></td>
<td>7</td>
<td>13</td>
</tr>
<tr>
<td>2M</td>
<td></td>
<td>11</td>
<td>20</td>
</tr>
<tr>
<td>VGA</td>
<td></td>
<td>64</td>
<td>100</td>
</tr>
<tr>
<td>16:9</td>
<td></td>
<td>11</td>
<td>20</td>
</tr>
</tbody>
</table>
Selects the frame interval in the [Multi Burst] mode (page 39).

<table>
<thead>
<tr>
<th>Interval</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/7.5 (1/7.5&quot;)</td>
<td>Select [Multi Burst] in [Mode] first, then set the desired frame interval in [Interval]. When you select a function other than [Multi Burst], this function is unavailable.</td>
</tr>
<tr>
<td>1/15 (1/15&quot;)</td>
<td></td>
</tr>
<tr>
<td>✔ 1/30 (1/30&quot;)</td>
<td></td>
</tr>
</tbody>
</table>

Adjusts the amount of flash light.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (+)</td>
<td>Toward +: Makes the flash level higher.</td>
</tr>
<tr>
<td>✔ Normal</td>
<td></td>
</tr>
<tr>
<td>− (−)</td>
<td>Toward −: Makes the flash level lower.</td>
</tr>
</tbody>
</table>

To change flash mode, see page 21.
Shooting menu

For details on the operation page 30

(Contrast): Adjusting the contrast of the image

Adjusts the contrast of the image.

| (+ ( )) | Toward +: Enhances the contrast. |
| ✓ Normal |
| ( − ( )) | Toward −: Reduces the contrast. |

(Sharpness): Adjusting the sharpness of the image

Adjusts the sharpness of the image.

| (+ ( )) | Toward +: Sharpens the image. |
| ✓ Normal |
| ( − ( )) | Toward −: Softens the image. |

(Setup): Changing Setup items

See page 50.
The default settings are marked with ✔.

**Folder**: Selecting the folder for viewing images

Selects the folder containing the image you want to play back when using the camera with “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Cancel</td>
</tr>
<tr>
<td>✔</td>
<td>Cancels the selection.</td>
</tr>
</tbody>
</table>

1. Select the desired folder with ◄/► on the control button.

2. Select [OK] with ▲, then press ●.

💡 On the folder

The camera stores images in a specified folder of a “Memory Stick Duo”. You can change the folder or create a new one.
- To create a new folder → [Create REC. Folder] (page 55)
- To change the folder for recording images → [Change REC. Folder] (page 56)
- When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.
  - ◄: Moves to the previous folder.
  - ►: Moves to the next folder.
  - ◄►: Moves to either the previous or next folders.

**Protect**: Preventing accidental erasure

Protects images against accidental erasure.

<table>
<thead>
<tr>
<th>✔</th>
<th>Protect (►)</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Exit</td>
<td>Exits the Protection function.</td>
</tr>
</tbody>
</table>

To protect images in single-image mode

1. Display the image you want to protect.
2. Press MENU to display the menu.
Viewing menu

③ Select [ ] (Protect) with  or  on the control button, then press .
The image is protected and the (protect) indicator appears on the image.

④ To protect other images, select the desired image with  or , then press .

To protect images in index mode

① Slide (Index) lever to display the index screen.
② Press MENU to display the menu.
③ Select [ ] (Protect) with  or  on the control button, then press .
④ Select [Select] with  or , then press .
⑤ Select the image you want to protect with  or , then press .
   A green (protect) indicator appears on the selected image.
⑥ Repeat step ⑤ to protect other images.
⑦ Press MENU.
⑧ Select [OK] with , then press .
The (protect) indicator turns white. The selected images are protected.
- To protect all images in the folder, select [All In This Folder] in step ④, and press . Select [On] with , then press .

To cancel the protection
In single-image mode
Press  in step ③ or ④ of “To protect images in single-image mode.”

In index mode
① Select the image for which you want to remove protection in step ⑤ of “To protect images in index mode.”
② Press  to turn the (protect) indicator gray.
③ Repeat the operation above for all images to be unprotected.
④ Press MENU, select [OK] with , and then press .
To cancel protection of all images in the folder
Select [All In This Folder] in step 4 of “To protect images in index mode,” and press ●. Select [Off] with ◀, then press ●.
- Note that formatting the internal memory or “Memory Stick Duo” erases all the data stored on the recording media, even if the images are protected, and these images cannot be restored.
- It may take some time to protect an image.

DPOF: Adding a Print order mark
Adds a (Print order) mark to images you want to print (page 87).

(Print): Printing images using a printer
See page 83.

(Slide): Playing back a series of images
Plays back recorded images in order (Slide show).

<table>
<thead>
<tr>
<th>Interval</th>
<th>Sets the slide show interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 sec</td>
<td></td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Repeat</th>
<th>Plays back images in a continuous loop.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slide show ends.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image</th>
<th>Plays back all the images in the selected folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td></td>
</tr>
<tr>
<td>All</td>
<td>Plays back all the images in a “Memory Stick Duo” in order.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start</th>
<th>Starts the slide show.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the slide show.</td>
</tr>
</tbody>
</table>
① Select [Interval], [Repeat] and [Image] with ▲/▼/◄/► on the control button.
② Select [Start] with ▼/►, then press ●.
The slide show starts.

To end the slide show, press ● pause the slide show. Select [Exit] with ▼, then press ●.

- When pausing during the slide show, you can display the previous/next image with ◄/►.
- The interval time is just a guideline, so it may vary depending on the image size, etc.

### (Resize): Changing the image size of a recorded image

![Image: Resize comparison](image)

You can change the image size of a recorded image (Resize), and save it as a new file. The original image is retained even after resizing.

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7M</td>
<td>For details on guidelines for selecting the image size, see page 24.</td>
</tr>
<tr>
<td>5M</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>✔ Cancel</td>
<td>Cancels resizing.</td>
</tr>
</tbody>
</table>

① Display the image you want to resize.
② Press MENU to display the menu.
③ Select [ ] (Resize) with ◄/► on the control button, then press ●.
④ Select the desired size with ▲/▼, then press ●.
The resized image is recorded in the recording folder as the newest file.

- For details on Image Size, see page 9.
- You cannot change the size of movies or Multi Burst images.
- When you change from a small size to a large size, the image quality deteriorates.
- You cannot resize to an image size of 3:2 or 16:9.
- When you resize a 3:2 or 16:9 image, the upper and lower black portions will be displayed on the image.
### Viewing menu

#### (Rotate): Rotating a still image

Rotates a still image.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Rotates an image. See the following procedure.</td>
</tr>
<tr>
<td>OK</td>
<td>Determines the rotation. See the following procedure.</td>
</tr>
<tr>
<td>✔️</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

1. Display the image to be rotated.
2. Press MENU to display the menu.
3. Select [.Rotate] with ◄/► on the control button, then press ●.
4. Select [.] with ▲, then rotate the image with ◄/►.
5. Select [OK] with ▲/▼, then press ●.

- You cannot rotate protected images, movies, or Multi Burst images.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.

#### (Divide): Cutting movies

Cuts movies, or deletes unnecessary scenes of movies. This is a recommended function to use when the internal memory or “Memory Stick Duo” capacity is insufficient, or when you attach movies to your e-mail messages.

- Note that the original movie is deleted and that number is skipped. Also note that you cannot restore files once you cut them.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>See the following procedure.</td>
</tr>
<tr>
<td>✔️</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
Example: Cutting a movie numbered 101_0002
This section describes an example of dividing a movie numbered 101_0002 and deleting it in the following file configuration.

1 Cutting scene A.

2 Cutting scene B.

3 Deleting scenes A and B if they are unnecessary.

4 Only the desired scenes remain.

Procedure

① Display the movie to be divided.
② Press MENU to display the menu.
③ Select [Divide] with ▲/▼ on the control button, then press ●.
④ Select [OK] with ▲, then press ●.

The movie starts.
5 Press ● at the desired cutting point.

- When you want to adjust the cutting point, select [\[ll/ll\]] (frame rewind/forward) and adjust the cutting point using ◀/▶.
- If you want to change the cutting point, select [Cancel]. The movie starts again.

6 Select [OK] with ▲/▼, and press ●.

7 Select [OK] with ▲, then press ●.
The movie is cut.
- The cut movies are assigned new numbers, and then recorded as the newest files in the selected recording folder.
- You cannot cut the following kinds of images.
  - Still images
  - Movies not long enough to cut (shorter than about two seconds)
  - Protected movies (page 43)

(Setup): Changing Setup items

See page 50.

Trimming: Recording an enlarged image

Records an enlarged image (page 28) as a new file.

<table>
<thead>
<tr>
<th>Trimming</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Return</td>
<td>Cancels trimming.</td>
</tr>
</tbody>
</table>

1 Press MENU during playback zoom to display the menu.
2 Select [Trimming] with ▲ on the control button, then press ●.
3 Select the image size with ▲/▼, then press ●.
The image is recorded, and the original image is displayed again.

- The trimmed image is recorded as the newest file in the selected recording folder, and the original image is retained.
- The quality of trimmed images may deteriorate.
- You cannot trim to an image size of 3:2 or 16:9 aspect ratio.
You can change the default settings using the Setup screen.

1. Press MENU to display the menu.

2. After pressing ► on the control button, go to the  (Setup) setting, then press ► again.

3. Press ▲▼◄► on the control button to select the item you want to set.
   The frame of the selected item turns yellow.

4. Press ● to enter the setting.

To turn off the  (Setup) screen, press MENU.
To return to the menu from the  (Setup) screen, press ▼ on the control button repeatedly.
- Press the shutter button halfway down to close the  (Setup) screen and return to the shooting mode.

**When the menu is not displayed**
Press MENU longer to display the  (Setup) screen.

**To cancel the  (Setup) setting**
Select [Cancel] if it appears, then press ● on the control button. If it does not appear, select the previous setting again.
- This setting is maintained even when the power is turned off.
The default settings are marked with ✅.

### AF Mode

Selects the auto focus operation mode.

<p>| ✅ Single (S AF) | Automatically adjusts the focus when the shutter button is pressed and held halfway down. This mode is useful for shooting stationary subjects. |</p>
<table>
<thead>
<tr>
<th>Monitor (M AF)</th>
<th>Automatically adjusts the focus before the shutter button is pressed and held halfway down. This mode shortens the time needed for focusing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>• Battery consumption is faster than in [Single] mode.</td>
</tr>
</tbody>
</table>

### Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

| ✅ Smart (Smart zoom) | Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [7M] or [3:2]. |
| - | • The maximum zoom scale of Smart zoom is shown in the following table. |
| Precision (Precision digital zoom) | Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates. |
| Off | Does not use the digital zoom. |

### Image size and maximum zoom scale using Smart zoom

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Approx. 3.6×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 4.5×</td>
</tr>
<tr>
<td>2M</td>
<td>Approx. 5.6×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 14×</td>
</tr>
<tr>
<td>16:9</td>
<td>Approx. 4.8×</td>
</tr>
</tbody>
</table>
• When you slide the zoom lever, the zoom scaling indicator appears as follows.

The W side of this line is the optical zoom area, and the T side is the digital zoom area

Zoom scaling indicator

• The maximum zoom scale of smart zoom/precision zoom includes the scale of the optical zoom.
• The AF range finder frame does not appear when using the digital zoom. The or indicator flashes, and AF operates with priority on subjects located near the center of the frame.
• When using the smart zoom, the image on the screen may look rough. However, this phenomenon has no effect on the recorded image.

**Function Guide**

When you operate the camera, the description of functions is displayed.

<table>
<thead>
<tr>
<th>On</th>
<th>Displays the function guide.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

**Red Eye Reduction**

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

- On (○)
  - Reduces the red-eye phenomenon.
  - The flash pre-strobes twice or more before shooting.

- Off
  - Does not use Red Eye Reduction.

• Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
• Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.
**AF Illuminator**

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The \( \text{ON} \) indicator appears at this time.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Auto</td>
<td>Uses the AF illuminator.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Does not use AF illuminator.</td>
</tr>
</tbody>
</table>

- If the AF illuminator light does not reach the subject sufficiently or the subject has no contrast, focus will not be achieved. (A distance of up to approximately 3.0 m (9 feet 10 1/8 inches) (zoom: W) / 2.0 m (6 feet 6 3/4 inches) (zoom: T) is recommended.)
- Focus is achieved as long as the AF illuminator light reaches the subject, even if the light is slightly off the center of the subject.
- When Focus preset is set (page 33), AF Illuminator does not function.
- The AF range finder frame does not appear. The \( \text{ON} \) or \( \text{OFF} \) indicator flashes, and AF operates with priority on subjects located near the center of the frame.
- The AF illuminator does not operate when \( \text{Twilight mode} \) or \( \text{Landscape mode} \) is selected in the Scene mode.
- The AF illuminator emits very bright light. Although there are no problems with safety, do not look directly into the AF illuminator emitter at close range.

**Auto Review**

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>On</td>
<td>Use the Auto Review.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

- If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
This item does not appear when a “Memory Stick Duo” is inserted in the camera.

**Format**

Formats the internal memory.

- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

1. Select [OK] with ▲ on the control button, then press ●.
   
   The message “All data in internal memory will be erased Ready?” appears.

2. Select [OK] with ▲, then press ●.
   
   The format is complete.

**To cancel the formatting**

Select [Cancel] in step ① or ②, then press ●.
This item appears only when a “Memory Stick Duo” is inserted in the camera.

**Format**

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

1. Select [OK] with ▲ on the control button, then press ●.
   
   The message “All data in Memory Stick will be erased Ready?” appears.

2. Select [OK] with ▲, then press ●.
   
   The format is complete.

**To cancel the formatting**

Select [Cancel] in step 1 or 2, then press ●.

**Create REC. Folder**

Creates a folder in a “Memory Stick Duo” for recording images.

1. Select [OK] with ▲ on the control button, then press ●.
   
   The folder creation screen appears.

2. Select [OK] with ▲, then press ●.
   
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

**To cancel the folder creation**

Select [Cancel] in step 1 or 2, then press ●.

- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF.”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 71).
Change REC. Folder

Changes the folder currently used for recording images.

① Select [OK] with ▲ on the control button, then press ●.
   The folder selection screen appears.

② Select the desired folder with ◀/▶, and [OK] with ▲, then press ●.

To cancel changing the recording folder
Select [Cancel] in step ① or ②, then press ●.

- You cannot select the “100MSDCF” folder as a recording folder.
- You cannot move recorded images to a different folder.
Copy

Copies all images in the internal memory to a “Memory Stick Duo”.

1. Insert a “Memory Stick Duo” having 64 MB or larger capacity.
2. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in internal memory will be copied Ready?” appears.
3. Select [OK] with ▲, then press ●.
   Copying starts.

To cancel the copying
Select [Cancel] in step 2 or 3, then press ●.

- Use a fully charged battery pack. If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.
- You cannot copy individual images.
- The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” after copying, then execute the [Format] command in (Internal Memory Tool) (page 54).
- When you copy the data in the internal Memory to the “Memory Stick Duo”, all the data will be copied. You cannot choose a specific folder on the “Memory Stick Duo” as the destination for the data to be copied.
- Even if you copy data, a (Print order) mark is not copied.
The default settings are marked with ✔.

**LCD Backlight (DSC-W55 only)**

Selects the brightness of the LCD backlight when using the camera with battery pack.

<table>
<thead>
<tr>
<th>Bright</th>
<th>Brightens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can change the setting by pressing DISP (Screen display switch) button longer.
- Selecting [Bright] uses up the battery pack charge faster.

**Beep**

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ On</td>
<td>Turns on the beep/shutter sound when you press the control button/ press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

**Language**

Selects the language to be used to display the menu items, warnings, and messages.

**Initialize**

Initializes the setting to the default setting.
Images stored in the internal memory are retained.

1. Select [OK] with ▲ on the control button, then press ●.
   The message “Initialize all settings Ready?” appears.

2. Select [OK] with ▲, then press ●.
   The settings are reset to the default setting.

**To cancel the resetting**

Select [Cancel] in step ① or ②, then press ●.

- Make sure that the power is not disconnected during resetting.
The default settings are marked with ✔.

### File Number

Selects the method used to assign file numbers to images.

<table>
<thead>
<tr>
<th>✔ Series</th>
<th>Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” is changed. (When the replaced “Memory Stick Duo” contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.)</td>
</tr>
</tbody>
</table>

### USB Connect

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35).

| PictBridge | Connects the camera to a PictBridge compliant printer (page 83). |
| PTP | When [PTP] (Picture Transfer Protocol) is set and the camera is connected to a computer, the images in the recording folder on the camera are copied to the computer. (Compatible with Windows XP and Mac OS X.) |
| Mass Storage | Establishes a Mass Storage connection between the camera and a computer or other USB device (page 67). |
| ✔ Auto | The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 67 and 83). |
|  | • If the camera and a PictBridge compliant printer cannot be connected when set to [Auto], change the setting to [PictBridge]. |
|  | • If the camera and a computer or other USB device cannot be connected when set to [Auto], change the setting to [Mass Storage]. |
**Video Out**

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 62 for the TV color system of the country or region where the camera is used.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NTSC</strong></td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td><strong>PAL</strong></td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>

**Clock Set**

Sets the date and time.

1. Select [OK] with ▲ on the control button, then press ●.
2. Select the date display format with ▲/▼, then press ●.
3. Select each item with ◀/▶ and set the numeric value with ▲/▼, then press ●.
4. Select [OK] with ◀, then press ●.

**To cancel the clock setting**

Select [Cancel], then press ●.
You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV.

1 Connect the camera to the TV.

DSC-W55

1 To audio/video input jacks

2 To the multi connector

Cable for multi-use terminal

- Place the camera with the screen facing upwards.

DSC-W35

1 To audio/video input jacks

2 To A/V OUT jack

A/V cable

- If your TV has stereo input jacks, connect the audio plug (black) of the cable for multi-use terminal (DSC-W55) or the A/V cable (DSC-W35) to the left audio jack.

2 Turn on the TV and set the TV/video input switch to “video.”

- For details, see the operating instructions supplied with the TV.

3 Press (Playback) button to turn on the camera.

Images shot with the camera appear on the TV screen.

Press \\
\( \equiv \) on the control button to select the desired image.

- When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 60).
Viewing images on a TV screen

On TV color systems
If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal (DSC-W55) or the A/V cable (DSC-W35). The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

NTSC system
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

PAL system
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

PAL-M system
Brazil

PAL-N system
Argentina, Paraguay, Uruguay

SECAM system
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 80).
This section describes the English version of screen contents.

Install the software (supplied) first (page 65)

Copying images to your computer (page 66)

- Viewing images on your computer

Enjoying images using the “Picture Motion Browser” (page 74)

- Viewing images saved on your computer
- Viewing photos organized by date
- Editing images
- Displaying the shooting locations of still images on maps online. (To do this, your computer needs to be connected to the Internet.)
- Create a new data disc. (CD burner drive or DVD burner drive required.)
- Printing or saving still images with the date.
The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional

- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**USB jack:** Provided as standard

**Recommended environment for using “Picture Motion Browser”**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional

**Sound card:** 16-bit stereo sound card with speakers

**CPU/Memory:** Pentium III 500 MHz or faster, 128 MB of RAM or more

(Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

**Software:** DirectX 9.0c or later

**Hard Disk:** Disk space required for installation—200 MB or more

**Display:** Screen resolution: 1024 \times 768 dots or more Colors: High Color (16-bit color) or more

- The software is compatible with DirectX technology. Installation of “DirectX” may be required.

---

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.

- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.

- Operations are not guaranteed when using a USB hub.

- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).

- There are three modes for a USB connection when connecting a computer. [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 59.

- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

---

**Technical Support**

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.

http://www.sony.net/
Installing the software (supplied)

You can install the software (supplied) using the following procedure.
• When using Windows 2000, do not connect the camera to the computer before installation.
• In Windows 2000/XP, log on as Administrator.
• When the software (supplied) is installed, the USB driver is installed automatically.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.

The installation menu screen appears.

• If it does not appear, double-click (My Computer) → (SONYPICTUTIL).

2 Click [Install].

The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].

The [Location Settings] screen appears.

4 Select the [Region] and [Country/Area], then click [Next].

When the [Welcome to the InstallShield Wizard for Sony Picture Utility] appears, click [Next].

The “License Agreement” screen appears.
Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

5 Follow the instructions on the screen to complete the installation.

• When the restarting confirmation message appears, restart the computer following the instructions on the screen.
• DirectX may be installed depending on system environment of your computer.

6 Remove the CD-ROM after the installation is complete.

After you install the software, a shortcut icon for the customers registration website is created on the desktop.

Once you register on the website, you can get secure and useful customer support.
http://www.sony.net/registration/di
Copying images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a Memory Stick slot
Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor. Insert the Memory Stick Duo Adaptor in the computer and copy the images.

- Even when you are using Windows 95/98/98 Second Edition/NT/Me, you can copy images by inserting the “Memory Stick Duo” into the Memory Stick slot on your computer.
- If the “Memory Stick PRO Duo” is not recognized, see page 94.

For a computer without a Memory Stick slot
Follow Stages 1 through 4 on pages 66 to 70 to copy images.

- When you are using Windows 2000, install the software (supplied) before proceeding. With Windows XP, installation is unnecessary.
- The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

With Windows 95/98/98 Second Edition/NT/Me:
This camera is not compatible with these version of the Windows operating system. When you use a computer without a Memory Stick slot, use a commercially available Memory Stick Reader/Writer to copy images from a “Memory Stick Duo” to your computer.

To copy images in the internal memory to your computer, copy the images to a “Memory Stick Duo” first, then copy them to your computer.

Stage 1: Preparing the camera and the computer

1 Insert a “Memory Stick Duo” with recorded images into the camera.
   • When copying images in the internal memory, this step is unnecessary.

2 Insert the sufficiently charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied) (DSC-W35/W55) and the USB, A/V, DC IN cable for multi-use terminal (not supplied) (DSC-W55 only).
   • When you copy images to your computer using a battery pack with little remaining charge, copying may fail or image data may become corrupted if the battery pack shuts down too soon.

3 Press (Playback) button to turn on the computer.

(Playback) button
Using your computer

Copying images to your computer

Stage 2: Connecting the camera and your computer

DSC-W55

1. To a USB jack
2. To the multi connector

Cable for multi-use terminal

DSC-W35

1. To the USB jack
2. To the \( \text{(USB)} \) jack

USB cable

• With Windows XP, the AutoPlay wizard appears on the desktop.

“USB Mode Mass Storage” appears on the screen of the camera.

When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.

* During communication, the access indicators turn red. Do not operate the computer until the indicators turn white.

• When the software (supplied) has been installed, the [Import Images] screen (page 75) may be displayed. In this case, you can import images using “Picture Motion Browser” directly.

Stage 3-A: Copying images to a computer

• For Windows 2000, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 69.
• For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 69.

This section describes an example of copying images to a “My Documents” folder.
1 After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

2 Click [Next].

The images saved on the “Memory Stick Duo” of the camera appear.
• If no “Memory Stick Duo” is inserted, images in the internal memory appear.

3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

Image copying starts. When the copying is completed, the “Other Options” screen appears.
• This section describes an example of copying images to the “My Documents” folder.
5 Click the radio button next to [Nothing. I'm finished working with these pictures] to select it, then click [Next].

The “Completing the Scanner and Camera Wizard” screen appears.

6 Click [Finish].

The wizard screen closes.

- To continue copying other images, disconnect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) (page 71). Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 67.

Stage 3-B: Copying images to a Computer

- For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 67.

This section describes an example of copying images to the “My Documents” folder.

1 Double-click [My Computer] → [Removable Disk] → [DCIM].

- If the “Removable Disk” icon is not displayed, see page 95.

2 Double-click the folder where the image files you want to copy are stored.

Then, right-click an image file to display the menu and click [Copy].

- On the storage destination of the image files, see (page 71).
3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

The image files are copied to the “My Documents” folder.
- When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 73), you may not be able to play back that image with your camera.

Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1 Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.
- If you are not using Windows XP, double-click [My Documents] on the desktop.

2 Double-click the desired image file.

The image is displayed.
To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35)
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

1. Double-click on the tasktray.
2. Click (Sony DSC) → [Stop].
3. Confirm the device on the confirmation window, then click [OK].
4. Click [OK].
The device is disconnected.

Step 4 is unnecessary for Windows XP.

Image file storage destinations and file names

The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

Example: viewing folders on Windows XP

A Folder containing image data recorded using a camera not equipped with the folder creating function

B Folder containing image data recorded using this camera
When no new folders are created, there are folders as follows:
- “Memory Stick Duo”; “101MSDCF” only
- Internal memory; “101_SONY” only

• You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
• You cannot record/playback any images to the “MISC” folder.
• Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  – Still image files: DSC0□□□□.JPG
  – Movie files: MOV0□□□□.MPG
  – Index image files that are recorded when you record movies: MOV0□□□□.THM
• For more information about folders, see pages 43 and 55.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, create a folder with your camera (page 55) first, and then copy the image file.

1 Right-click the image file, then click [Rename]. Change the file name to “DSC0xxxx.”

Enter a number from 0001 to 9999 for xxxx.

- If the overwrite confirmation message appears, enter a different number.
- An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is MPG. Do not change the extension.

2 Copy the image file to the “Memory Stick Duo” folder in the following order.

① Right-click the image file, then click [Copy].
② Double-click [Removable Disk] or [Sony MemoryStick] in [My Computer].
③ Right-click the [□□□□MSDCF] folder in the [DCIM] folder, then click [Paste].

- □□□□ stands for any number within the range from 100 to 999.
Using the “Picture Motion Browser” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Picture Motion Browser” and gives the basic instructions.

“Picture Motion Browser” overview

With the “Picture Motion Browser” you can:

- Import images shot with the camera and display them on the computer.
- Organize images on the computer on a calendar by shooting date to view them.
- Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
- Still images can be printed or saved with the date.
- You can create a data disc using a CD burner drive or DVD burner drive.
- For details on the “Picture Motion Browser,” refer to the Help.

To access the Help, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [Picture Motion Browser].

Starting and exiting the “Picture Motion Browser”

Starting the “Picture Motion Browser”

Double-click the  (Picture Motion Browser) icon on the desktop.
Or, from the Start menu: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Picture Motion Browser].

Exiting the “Picture Motion Browser”

Click  button in the top right corner of the screen.

Basic instructions

Follow these steps to import and view images from the camera.

Importing images

1 Make sure “Media Check Tool”* is running.

Look for a  (Media Check Tool) icon in the taskbar.

* “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.

If there is no  icon: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Tools] → [Media Check Tool].
Using your computer

Using the “Picture Motion Browser” (supplied)

2 Connect the camera to your computer with the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35).

After the camera is automatically detected, the [Import Images] screen is displayed.

- If you use the Memory Stick slot, refer to page 66 first.
- In Windows XP, if the Auto Play Wizard appears, close it.

3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.

- For instructions on changing the “Folder to be imported”, refer to page 78.

Viewing images

1 Checking imported images

When importing is complete, the “Picture Motion Browser” starts. Thumbnails of the imported images are displayed.

- The “My Pictures” folder is set as the default folder in “Viewed folders”.
- You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.

② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.

③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.

④ To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.
Using the “Picture Motion Browser” (supplied)

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

• You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

• To play or pause the slide show, click the button on the lower left of the screen.
• To stop the slide show, click the button on the lower left of the screen.

• To list images from a particular year or month, click that period on the left of the screen.
Creating a data disc

Images can be saved in CD or DVD as a data disc.
- CD burner drive or DVD burner drive required.
- The following disc can be used for creating a data disc.
  - CD-R/RW (12 cm)
  - DVD±R/RW (12 cm)
  - DVD+R DL (12 cm)

1 Select images to save on the disc.
   - To select consecutive images, click the first image, then press and hold down “Shift” key while you click the last image.
   - To select two or more non-consecutive images, press and hold down “Ctrl” key while clicking images.

2 Click the button on the tool bar.
   The [Create Data Disc] display appears.

3 Click [Start].

4 Follow the display instructions to proceed with creating the data disc.
   - To add desired images, drag and drop on the [Create Data Disc] display.

Using Map View to display still images on a map

If your still images have position information, you can see the images on maps online with Map View.
- To use the Map View function, your computer needs to be connected to the Internet.

1 Select a thumbnail marked with .

2 Click .
   The Map View main window appears.
   • Maps and satellite images powered by Google Maps mapping service.
   • You can later add position information on the still images, using the Map View. For details, see the Help of Map View.

Selecting all images in a folder

Click the [folders] tab, then right-click on the desired folder icon and select [Create Data Disc]. All images in a folder can be selected.
Using the “Picture Motion Browser” (supplied)

Other functions
Preparation of images stored on the computer for viewing
To view them, register the folder that contains the images as one of the “Viewed folders”.

1 Click  on the main screen, or choose [Register Folders to View] from the [File] menu.

The settings screen for “Viewed folders” registration is displayed.

2 Specify the folder with images for importing to register the folder as one of the “Viewed folders”.

3 Click [OK].

The image information is registered in the database.

- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”
To change the “Folder to be imported”, access the “Import Settings” screen.

1 Choose [Import Settings] → [Location for Imported Images] from the [File] menu.

The “Location for Imported Images” screen is displayed.

2 Choose the “Folder to be imported”.

- You can specify the “Folder to be imported” from folders registered as “Viewed folders.”

Updating image registration information
To update image information, choose [Update Database] from the [Tools] menu.
- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

Saving images with the date
1 Double-click an image to display it.
2 Click  and select [Insert Date] from the drop-down list.
3 Select your desired color and position, and then click [OK].
4 Click  to save.

Printing images with the date
1 Select the still image you want to print.
2 Click  on the toolbar.
3 Click the check box of [Print date taken] in Print Options.
4 Click [Print].
To uninstall the “Picture Motion Browser”

① Click [Start] → [Control Panel] (in Windows 2000, [Start] → [Settings] → [Control Panel]), then double-click [Add/Remove Programs].

② Select [Sony Picture Utility], then click [Remove] (in Windows 2000, [Change/Remove]) to execute the uninstallation.
Using your Macintosh computer

You can copy images to your Macintosh computer.
- “Picture Motion Browser” is not compatible with Macintosh computers.

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Mac OS 9.1/9.2/ Mac OS X(v10.1 to v10.4)

**USB jack:** Provided as standard

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 59.
- When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

**Copying and viewing images on a computer**

1. **Prepare the camera and a Macintosh computer.**
   Perform the same procedure as described in “Stage 1: Preparing the camera and the computer” on page 66.

2. **Connect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35).**
   Perform the same procedure as described in “Stage 2: Connecting the camera and your computer” on page 67.

3. **Copy image files to the Macintosh computer.**
   ① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
   ② Drag and drop the image files to the hard disk icon.
   The image files are copied to the hard disk.
   • For details on the storage location of the images and file names, see page 71.
4 View images on the computer.

   Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.

---

To delete the USB connection

Perform the procedures listed below beforehand when:

- Disconnecting the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35)
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

---

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
When you print images shot in [16:9] mode, both edges may be cut off, so be sure to check before printing (page 97).

### Printing directly using a PictBridge compliant printer (page 83)

You can print images by connecting the camera directly to a PictBridge compliant printer.

### Printing directly using a “Memory Stick” compliant printer

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

### Printing using a computer

You can copy images to a computer using the “Picture Motion Browser” software (supplied) and print the images. You can print images date inserted (page 78).

### Printing at a shop (page 87)

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a (Print order) mark on images which you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

**PictBridge**

- “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)

**In single-image mode**

You can print a single image on a printing sheet.

![Single-image example](image)

**In index mode**

You can print several images at a reduced size on a printing sheet. You can print a set of either the same images (1) or different images (2).

![Index print example](image)

1. An index print function may not be provided depending on the printer.
2. The quantity of images that can be printed as an index image differ depending on the printer.
3. You cannot print movies.
4. If the \_\_ indicator flashes on the screen of the camera for about five seconds (error notification), check the connected printer.

**Stage 1: Preparing the camera**

Prepare the camera to connect it to the printer via a USB connection. When connecting the camera to a printer that is recognized when [USB Connect] is set to [Auto], Stage 1 is unnecessary.

![Camera setup](image)

- It is recommended to use a fully charged battery pack to prevent the power from turning off partway through printing.

1. Press MENU to display the menu.
2. Press ▶ on the control button to select (Setup).
3. Select [ ] (Setup 2) with ▼, then select [USB Connect] with ▲/▼/▶.
4. Select [PictBridge] with ▶/▲, then press ●.

The USB mode is set.
Stage 2: Connecting the camera to the printer

1 Connect the camera to the printer.

DSC-W55

2 To the multi connector

Cable for multi-use terminal

1 To the USB jack

DSC-W35

USB cable

2 To the (USB) jack

1 To the USB jack

2 Turn on your camera and the printer.

After the connection is made, the indicator appears.

The camera is set to playback mode, then an image and the print menu appear on the screen.
Printing images directly using a PictBridge compliant printer

**Stage 3: Printing**

Regardless of what the mode dial is set to, the print menu appears when you complete Stage 2.

1. Select the desired printing method with ▲/▼ on the control button, then press ●.

   - [All In This Folder]
     Prints all the images in the folder.

   - [DPOF image]
     Prints all the images with a 📝 (Print order) mark (page 87) regardless of the displayed image.

   - [Select]
     Selects images and prints all the selected images.

     ① Select the image you want to print with ◀/▶, then press ●.
     The ✔ mark appears on the selected image.
     • To select other images, repeat this procedure.

     ② Select [Print] with ▼, then press ●.

   - [This image]
     Prints a displayed image.
     • If you select [This image] and set [Index] to [On] in step 2, you can print a set of the same images as an index image.

2. Select print settings with ▲/▼/◀/▶.

   - [Index]
     Select [On] to print as an index image.

   - [Size]
     Select the size of the printing sheet.

   - [Date]
     Select [Day&Time] or [Date] to insert the date and time on images.
     • When you choose [Date], the date will be inserted in the order you select (page 60). This function may not be provided depending on the printer.

   - [Quantity]
     When [Index] is set to [Off]:
     Select the number of sheets of an image that you want to print. The image will be printed as a single image.

     When [Index] is set to [On]:
     Select the number of sets of images that you want to print as an index image. If you selected [This image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.
     • The designated number of images may not all fit onto a single sheet depending on the quantity of images.
Printing images directly using a PictBridge compliant printer

3 Select [OK] with ▼/►, then press ●.

The image is printed.

- Do not disconnect the cable for multi-use terminal (DSC-W55) or remove the USB cable (DSC-W35) while the (PictBridge Connecting) indicator appears on the screen.

![Indicator Image]

To print other images

After step 3, select [Select] and the desired image with ▲/▼, then perform from step 1.

To print images on the index screen

Perform “Stage 1: Preparing the camera” (page 83) and “Stage 2: Connecting the camera to the printer” (page 84), then proceed with the following.

When you connect the camera to a printer, the print menu appears. Select [Cancel] to turn off the print menu, then proceed as follows.

① Slide (Index) lever.
   The index screen appears.

② Press MENU to display the menu.

③ Select [▲] (Print) with ►, then press ●.

④ Select the desired printing method with ▲/▼, then press ●.

- [Select]
  Selects images and prints all the selected images.
  Select the image you want to print with ▲/▼/◄/►, then press ● to display the ✔ mark. (Repeat this procedure to select other images.) Then, press MENU.

- [DPOF image]
  Prints all the images with a (Print order) mark regardless of the displayed image.

- [All In This Folder]
  Prints all the images in the folder.

⑤ Perform steps 2 and 3 of “Stage 3: Printing” (page 85).
You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

What is DPOF?

DPOF (Digital Print Order Format) is a function allowing you to make a (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

- You can also print the images with the (Print order) mark using a printer that conforms to the DPOF (Digital Print Order Format) standard or using a PictBridge compliant printer.
- You cannot mark movies.
- When you mark images shot in [Multi Burst] mode, all the images are printed on one sheet divided into 16 panels.

When taking a “Memory Stick Duo” to a shop

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
- Be sure to take the Memory Stick Duo Adaptor with it.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.

Marking in single-image mode

1. Display the image you want to print.
2. Press MENU to display the menu.
3. Select [DPOF] with ◀/▶, then press ●.
   A (Print order) mark is marked on the image.
4. To mark other images, display the desired image with ◀/▶, then press ●.

To remove the mark in single-image mode

Press ● in step 3 or 4.
Marking in index mode

1 Display the index screen (page 29).

2 Press MENU to display the menu.

3 Select [DPOF] with ◀/▶, then press ●.

4 Select [Select] with ▲/▼, then press ●.
   - You cannot add a mark in [All In This Folder].

5 Select the image you want to mark with ▲/▼/◀/▶, then press ●.
   A green mark appears on the selected image.

6 Repeat step 5 to mark other images.

7 Press MENU.

8 Select [OK] with ▶, then press ●.
   The mark turns white.

To cancel, select [Cancel] in step 4 or select [Exit] in step 8, then press ●.

To remove the mark in index mode
Select the images from which you want to remove the mark in step 5, then press ●.

To remove all the marks in the folder
Select [All In This Folder] in step 4, then press ●. Select [Off], then press ●.
If you experience trouble with your camera, try the following solutions.

1. **Check the items on pages 90 to 99.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 100.

2. **Remove the battery pack, and insert the battery pack again after about one minute, and turn on the power.**

3. **Initialize the settings (page 58).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

Please understand that you give your consent that the contents of the internal memory may be checked when you send your camera to be repaired.

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.
Troubleshooting

Battery pack and power

The battery pack cannot be installed.
- Install the battery pack correctly using the tip of the battery pack to push the battery eject lever toward the bottom of the camera.

Cannot turn on the camera.
- Install the battery pack correctly.
- The battery pack is discharged. Install charged battery pack.
- The battery pack is dead (page 106). Replace it with a new one.
- Use a recommended battery pack.

The power turns off suddenly.
- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
- The battery pack is dead (page 106). Replace it with a new one.

The battery remaining indicator is incorrect.
- This phenomenon occurs when you use the camera in an extremely hot or cold location.
- The displayed battery remaining differs from the current one. Fully discharge and then charge the battery pack to correct the display.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 106). Replace it with a new one.

The battery cannot be charged.
- You cannot charge the battery with the AC adaptor (not supplied).

Shooting still images/movies

The screen does not turn on even when the power is turned on.
- Turn on the screen (page 16).

Your camera cannot record images.
- Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  - Delete unnecessary images (page 28).
  - Change the “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 104).
- You cannot record images while charging the flash.
- Set the mode dial to a position other than when shooting still images.
- Set the mode dial to when shooting movies.
The image size is set to [640(Fine)] when recording movies. Do one of the following:
- Set the image size to other than [640(Fine)].
- Insert a “Memory Stick PRO Duo”.

The camera stops partway through recording a movie.
- The camera stops recording automatically when the file size reaches approximately 2GB.

The subject is not visible on the screen.
- Your camera is set to the Playback mode. Press  (Playback) button to change to the recording mode (page 28).

Recording takes a long time.
- The NR slow shutter function is activated (page 13). This is not a malfunction.

The image is out of focus.
- The subject is too close. Shoot in  (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 2 cm (13/16 inches) (W)/30 cm (11 7/8 inches) (T), when shooting.
-  (Twilight mode) or  (Landscape mode) is selected in the Scene mode when shooting still images.
- The Focus preset function is selected. Select the auto focus mode (page 33).
- Refer to “If the subject is out of focus” on page 34.

Zoom does not work.
- The smart zoom cannot be used when:
  - The image size is set to [7M] or [3:2].
  - Shooting in Multi Burst mode.
- The digital zoom cannot be used while shooting movies.
- You cannot change the zoom scale while shooting a movie.

The flash does not work.
- The flash is set to  (Flash forced off) (page 21).
- You cannot use the flash when:
  - [Mode] (REC Mode) is set to [Burst] or [Multi Burst] (page 39).
  -  (High Sensitivity mode) or  (Twilight mode) is selected in the Scene mode (page 26).
  - Shooting movies.
- Set the flash to  (Flash forced on) when  (Landscape mode),  (Beach mode), or  (Snow mode) is selected in the Scene mode (page 21).

Fuzzy specks appear in images shot using the flash.
- Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.
Troubleshooting

The close-up shoot function (Macro) does not work.

- 🌃 (Twilight mode) or 🌢 (Landscape mode) is selected in the Scene mode (page 27).

The date and time are not displayed.

- While shooting, the date and time are not displayed. They are displayed only during playback.

Cannot insert dates on images.

- This camera does not have a feature for superimposing dates on images (page 98). You can print or save images with the date using “Picture Motion Browser” (page 78).

The F value and shutter speed flash when you press and hold the shutter button halfway down.

- The exposure is incorrect. Correct the exposure (page 23).

The screen is too dark or too bright.

- Adjust the brightness of the LCD backlight (DSC-W55 only) (pages 16, 58).

The image is too dark.

- You are shooting a subject with a light source behind the subject. Select the metering mode (page 35) or adjust the exposure (page 23).
- Turn on the screen (page 16).

The image is too bright.

- Adjust the exposure (page 23).

The image colors are not correct.

- Set [COLOR] (Color Mode) to [Normal] (page 32).

Vertical streaks appear when you are shooting a very bright subject.

- The smear phenomenon is occurring. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.

- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.

- Set [Red Eye Reduction] in the 📷 (Setup) menu to [On] (page 52).
- Shoot the subject at a distance closer than the flash range using the flash.
- Light the room and shoot the subject.
Troubleshooting

Dots appear and remain on the screen.
- This is not a malfunction. These dots are not recorded (page 2).

The image seen through the finder does not indicate the actual recordable range.
- The parallax phenomenon is occurring when the subject is close. To confirm the recordable range, use the LCD screen.

Cannot shoot images in succession.
- The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 28).
- The battery level is low. Install charged battery pack.

Viewing images

Your camera cannot play back images.
- Press  (Playback) button (page 28).
- The folder/file name has been changed on your computer (page 73).
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB connection (page 71).

The date and time are not displayed.
- DISP (Screen display switch) button is turned off (page 16).

The image appears rough right after playback starts.
- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

Color unevenness may appear during video playback.
- This is not a malfunction. The recorded images are not affected.

Images are not displayed on the screen.
- Remove the cable for multi-use terminal (DSC-W55) or the A/V cable (DSC-W35) if the cable is connected (page 61).

The image does not appear on the TV screen.
- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 60).
- Check whether the connection is correct (page 61).
- When the cable for multi-use terminal is connected to the USB jack, remove the cable (DSC-W55 only).
Troubleshooting

Deleting/Editing images

Your camera cannot delete an image.
- Cancel the protection (page 44).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 104).

You have deleted an image by mistake.
- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 43), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 104) to prevent accidental erasure.

The resizing function does not work.
- You cannot resize movies and Multi Burst images.

You cannot cut a movie.
- The movie is not long enough to cut (shorter than about two seconds).
- Cancel the protection (page 44).

Computers

You do not know if the OS of your computer is compatible with the camera.
- Check “Recommended computer environment” on page 64 for Windows, and page 80 for Macintosh.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.
- Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Readers/ Writers made by manufacturers other than Sony should contact those manufacturers.
- If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (pages 67 and 80). The computer recognizes the “Memory Stick PRO Duo”.

Your computer does not recognize your camera.
- Turn on the camera.
- When the battery level is low, install the charged battery pack, or use the AC Adaptor (not supplied) (page 66).
- Use the cable for multi-use terminal (supplied) (DSC-W55) or the USB cable (supplied) (DSC-W35) (page 67).
- Disconnect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) from both the computer and the camera, and connect it again firmly.
Troubleshooting

- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
- Connect the camera directly to your computer without passing through a USB hub or other device (page 67).
- The software (supplied) is not installed. Install the software (page 65).
- Your computer does not properly recognize the device because you connected the camera and your computer with the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) before you install the software (supplied). Delete the erroneously recognized device from your computer, then install the USB driver (see the next item).

The “Removable disk” icon does not appear on the computer screen when you connect your computer to the camera.

- Follow the procedure below to install the USB driver again. The following procedure is for a Windows computer.
  1. Right-click [My Computer] to display the menu, then click [Properties].
     The “System Properties” screen appears.
  2. Click [Hardware] → [Device Manager].
     The “Device Manager” appears.
  3. Right-click [Sony DSC], then click [Uninstall] → [OK].
     The device is deleted.
  4. Install the software (page 65).
     A USB driver is also installed.

You cannot copy images.

- Connect the camera and your computer correctly making a USB connection (page 67).
- Follow the designated copy procedure for your OS (pages 67 and 80).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 55).

After making a USB connection, “Picture Motion Browser” does not start automatically.

- Start “Media Check Tool” (page 74).
- Make the USB connection after the computer is turned on (page 67).

The image cannot be played back on a computer.

- If you are using “Picture Motion Browser,” refer to the Help.
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.

- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 66).
Troubleshooting

You cannot print an image.
• Refer to the operation manual of the printer.

Images once copied to a computer cannot be viewed on the camera.
• Copy them to a folder recognized by the camera, such as “101MSDCF” (page 71).
• Operate correctly (page 73).

Picture Motion Browser

Images are not displayed correctly with “Picture Motion Browser.”
• Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 78).

You cannot find images imported with “Picture Motion Browser.”
• Look in the “My Pictures” folder.
• If you have changed the default settings, refer to “Changing the “Folder to be imported”” on page 78 and check what folder is used for importing.

You want to change the “Folder to be imported”.
• Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Picture Motion Browser” to register it in “Viewed folders” (page 78).

All imported images are displayed on the calendar with the date January 1.
• The date has not been set on the camera. Set the date on the camera (page 60).

The ☑ mark appears.
• If you have renamed or deleted image files/folders in other software, the image registration information is not updated. Select [Update Database] from the [Tools] menu to update image registration information.

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.
• Insert it in the correct direction.

Cannot format a “Memory Stick Duo”.
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 104).
Troubleshooting

You have formatted a “Memory Stick Duo” by mistake.

- All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 104).

**Internal memory**

Cannot play back or record images using the internal memory.

- There is a “Memory Stick Duo” inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

- The “Memory Stick Duo” is full. Check the capacity (64 MB or more recommended).

Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.

- Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

**Printing**

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both edges cut off.

- Depending on your printer, the left, right, top, and bottom edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the edge of the image may be cut off.
- When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
- When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

Images with 16 frames are printed.

- Images shot in the Multi Burst mode are recorded as a single image with 16 frames. You cannot print the image frame-by-frame.

Cannot print images with the date.

- You can print images with the date using “Picture Motion Browser” (page 78).
- This camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
Troubleshooting

- When you print images at a shop, images can be printed with the date if you ask them to do so.

PictBridge compliant printer

A connection cannot be established.
- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] in the (Setup) menu (page 59).
- Disconnect and connect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Cannot print images.
- Check that the camera and the printer are properly connected using the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35).
- Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) again. If you still cannot print your images, disconnect the cable, turn the printer off and then on, then connect the cable again.
- Movies cannot be printed.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.
- Confirm that you have disconnected the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) before the (PictBridge Connecting) mark disappears.

Cannot insert the date or print images in the index mode.
- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.
- Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 85).

Cannot select the print size.
- Consult the printer manufacturer as to whether the printer can provide the desired size.
Troubleshooting

Cannot print the image at the size selected.
- Disconnect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) and reconnect it whenever you change the paper size after the printer has been connected to the camera.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 85) or the printer.

Cannot operate the camera after canceling printing.
- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Others

The camera does not function with the lens portion extended.
- Do not attempt to force the lens that has stopped moving.
- Insert a charged battery, then turn on the camera again.

The lens gets fogged.
- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.
- This is not a malfunction.

The lens does not move when you turn off the camera.
- The battery pack is discharged. Replace it with a charged battery pack.

The Clock Set screen appears when you turn on the camera.
- Set the date and time again (page 60).

You want to change the date or time.
- Set the date and time again (page 60).
Warning indicators and messages

Self-diagnosis display
If a code starting with a letter of the alphabet appears, your camera has a self-diagnosis display. The last two digits (indicated by ☐☐) will differ depending on the state of the camera. If you are unable to solve the problem even after trying the following corrective actions a few times, your camera may need repair. Contact your Sony dealer or local authorized Sony service facility.

C:32:☐☐
- There is trouble with your camera’s hardware. Turn the power off and on again.

C:13:☐☐
- The camera cannot read or write data on the “Memory Stick Duo”. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” several times.
- The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (pages 54, 55).
- The inserted “Memory Stick Duo” cannot be used with your camera, or the data is damaged. Insert a new “Memory Stick Duo”.

E:61:☐☐
E:91:☐☐
- A camera malfunction has occurred. Initialize the camera (page 58), then turn the power on again.

Messages
If the following messages appear, follow the instructions.

Æ
- The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
- The battery inserted is not an NP-BG1 battery pack.

System error
- Turn the power off and then on again.

Internal memory error
- Turn the power off and then on again.

Reinsert the Memory Stick
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in your camera (page 104).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
- The inserted “Memory Stick Duo” cannot be used in your camera (page 104).

Format error
- Format the media again (pages 54 and 55).
Warning indicators and messages

Memory Stick locked
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 104).

No memory space in internal memory
No memory space in Memory Stick
- Delete unnecessary images or files (page 28).

Read only memory
- Your camera cannot record or delete images on this “Memory Stick Duo”.

No file
- No images that can be played have been recorded in the internal memory.

No file in this folder
- No images that can be played have been recorded in this folder.
- You did not operate correctly when copying images from your computer (page 73).

Folder error
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCD). Select another folders, or create a new folder (pages 55, 56).

Cannot record
- The camera cannot record images in the selected folder. Select a different folder (page 56).

File error
- An error occurred while the image was playing back.

File protect
- Release the protection (page 44).

Image size over
- You are playing back an image of a size that cannot be played back on your camera.

Cannot divide
- The movie is not long enough to be divided (shorter than about two seconds).
- The file is not a movie.

Invalid operation
- You are trying to play back a file that is not compatible with the camera.

(Vibration warning indicator)
- Camera shake may occur due to insufficient light. Use the flash or mount the camera on a tripod to secure the camera.

640(Fine) is not available
- 640(Fine) size movies can be recorded only using a “Memory Stick PRO Duo”. Insert a “Memory Stick PRO Duo” or set the image size to a size other than [640(Fine)].
Enable printer to connect

- [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
- The connection is not established. Disconnect and connect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35) again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Connect to PictBridge device

- You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

No printable image

- You tried to execute [DPOF image] without placing a DPOF (Print order) mark on the image(s).
- You tried to execute [All In This Folder] while a folder that holds only movies was selected. You cannot print movies.

Printer busy
Paper error
No Paper
Ink error
Low Ink
No Ink

- Check the printer.

Processing

- The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

- The data transmission to the printer may not be completed yet. Do not disconnect the cable for multi-use terminal (DSC-W55) or the USB cable (DSC-W35).
To use your camera abroad — Power sources

You can use your camera, the battery charger (supplied), and the AC-LS5K AC Adaptor (not supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
On the “Memory Stick”

A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2*3</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.
*2 Supports high-speed data transfer using a parallel interface.
*3 640(Fine) size movies can be recorded.

Notes on using a “Memory Stick Duo” (not supplied)

- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.

Some “Memory Stick Duo” cards do not have a write-protect switch. The position and/or the shape of the write-protect switch may differ depending on the “Memory Stick Duo” you use.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.

- This product is compatible with “Memory Stick Micro” (“M2”). “M2” is the abbreviation for the “Memory Stick Micro.”
- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.
On the “Memory Stick”

- Do not use or store the “Memory Stick Duo” under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

- To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 8GB have been confirmed to operate properly with this camera.

Notes on using “Memory Stick Micro” (not supplied)

- To use a “Memory Stick Micro” with this camera, you need a Duo-sized M2 Adaptor. Insert the “Memory Stick Micro” into the Duo-sized M2 Adaptor, and then insert the adaptor into the Memory Stick Duo slot. If you insert a “Memory Stick Micro” into this camera without using a Duo-sized M2 Adaptor, you might not be able to remove it from the camera.

- Do not leave the “Memory Stick Micro” within the reach of small children. They might accidentally swallow it.
On the battery pack

On charging the battery pack
We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). You may not be able to efficiently charge the battery pack outside of this temperature range.

Effective use of the battery pack
• Battery performance decreases in low temperature surroundings. So, the time that the battery pack can be used is shorter in cold places. We recommend the following to ensure longer battery pack use:
  – Put the battery pack in a pocket close to your body to warm it up, and insert it in your camera immediately before you start shooting.
• The battery pack will run out quickly if you use the flash or zoom frequently.
• We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
• Do not expose the battery pack to water. The battery pack is not water-resistant.
• Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack
• If the battery pack is not to be used for a long time, fully charge it and then fully use it up once a year on your camera before storing the battery pack in a dry, cool place. Repeat this charging and using up once a year to maintain the battery pack’s function.
• To use the battery pack up, leave your camera in slide show playback mode (page 45) until the power goes off.
• To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life
• The battery life is limited. Battery capacity decreases little by little as you use it more and more, and as time passes. If the battery operating time seems shortened considerably, a probable cause is that the battery pack has reached the end of its life. Buy a new battery pack.
• The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.
On the battery charger

- Do not charge any other battery pack except NP-BG type battery packs in the battery charger (supplied) with your camera. Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.

- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be shortened.

- When the CHARGE lamp flashes, this may indicate a battery error or that a battery pack other than the specified type has been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.

- If the battery charger is dirty, charging may not be performed successfully. Clean the battery charger with dry cloth, etc.
**Index**

<table>
<thead>
<tr>
<th>A</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/V cable</td>
<td>61</td>
</tr>
<tr>
<td>Adjusting EV</td>
<td>23</td>
</tr>
<tr>
<td>AE/AF lock indicator</td>
<td>34</td>
</tr>
<tr>
<td>AF Illuminator</td>
<td>53</td>
</tr>
<tr>
<td>AF lock</td>
<td>34</td>
</tr>
<tr>
<td>AF Mode</td>
<td>51</td>
</tr>
<tr>
<td>AF range finder frame</td>
<td>33</td>
</tr>
<tr>
<td>AF range finder frame indicator</td>
<td>33</td>
</tr>
<tr>
<td>Aperture</td>
<td>7</td>
</tr>
<tr>
<td>Auto adjustment mode</td>
<td>19</td>
</tr>
<tr>
<td>Auto Focus</td>
<td>6</td>
</tr>
<tr>
<td>Auto Review</td>
<td>53</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W</td>
<td>32</td>
</tr>
<tr>
<td>Battery charger</td>
<td>107</td>
</tr>
<tr>
<td>Battery pack</td>
<td>106</td>
</tr>
<tr>
<td>Beach mode</td>
<td>26</td>
</tr>
<tr>
<td>Beep</td>
<td>58</td>
</tr>
<tr>
<td>Blur</td>
<td>6</td>
</tr>
<tr>
<td>Burst</td>
<td>39</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable for multi-use terminal</td>
<td>61, 67, 84</td>
</tr>
<tr>
<td>Camera</td>
<td>51</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>65</td>
</tr>
<tr>
<td>Center AF</td>
<td>33</td>
</tr>
<tr>
<td>Center-weighted metering</td>
<td>35</td>
</tr>
<tr>
<td>Change REC. Folder</td>
<td>56</td>
</tr>
<tr>
<td>Clock Set</td>
<td>60</td>
</tr>
<tr>
<td>Cloudy</td>
<td>36</td>
</tr>
<tr>
<td>Color</td>
<td>8</td>
</tr>
<tr>
<td>Color Mode</td>
<td>32</td>
</tr>
<tr>
<td>Compression ratio</td>
<td>9</td>
</tr>
<tr>
<td>Computer</td>
<td>63</td>
</tr>
<tr>
<td>Copying images</td>
<td>66, 80</td>
</tr>
<tr>
<td>Macintosh</td>
<td>80</td>
</tr>
<tr>
<td>Recommended environment</td>
<td>64, 80</td>
</tr>
<tr>
<td>Software</td>
<td>65</td>
</tr>
<tr>
<td>Viewing image files stored on a computer with your camera</td>
<td>73</td>
</tr>
<tr>
<td>Windows</td>
<td>63</td>
</tr>
</tbody>
</table>

**Connecting**

| Computer               | 67   |
| Printer                | 84   |
| TV                     | 61   |
| Contrast               | 42   |
| Copy                   | 57   |
| Copying images to your computer | 66 |
| Create REC. Folder     | 55   |

<table>
<thead>
<tr>
<th>D</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daylight</td>
<td>37</td>
</tr>
<tr>
<td>DC IN jack</td>
<td>11</td>
</tr>
<tr>
<td>Delete</td>
<td>28</td>
</tr>
<tr>
<td>Format</td>
<td>54, 55</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>51</td>
</tr>
<tr>
<td>DirectX</td>
<td>64</td>
</tr>
<tr>
<td>Divide</td>
<td>47</td>
</tr>
<tr>
<td>DPOF</td>
<td>87</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>EV</td>
<td>23</td>
</tr>
<tr>
<td>Exposure</td>
<td>7</td>
</tr>
<tr>
<td>Extension</td>
<td>73</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>71</td>
</tr>
<tr>
<td>File Number</td>
<td>59</td>
</tr>
<tr>
<td>File storage destination</td>
<td>71</td>
</tr>
<tr>
<td>Fine</td>
<td>38</td>
</tr>
<tr>
<td>Flash (White balance)</td>
<td>36</td>
</tr>
</tbody>
</table>

| Flash forced off       | 21   |
| Flash forced on        | 21   |
| Flash Level            | 41   |
| Flash mode             | 21   |
| Fluorescent            | 36   |
| Focus                  | 6, 33 |
| Focus preset           | 33   |
| Folder                 | 43   |
| Changing               | 56   |
| Creating               | 55   |
| Format                 | 54, 55 |
| Function Guide         | 52   |

<table>
<thead>
<tr>
<th>H</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Sensitivity mode</td>
<td>26</td>
</tr>
<tr>
<td>Histogram</td>
<td>16, 23</td>
</tr>
<tr>
<td>Holding the camera</td>
<td>6, 19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifying parts</td>
<td>10</td>
</tr>
<tr>
<td>Image file storage destinations and file names</td>
<td>71</td>
</tr>
<tr>
<td>Image quality</td>
<td>9, 38</td>
</tr>
<tr>
<td>Image size</td>
<td>9, 24</td>
</tr>
<tr>
<td>Incandescent</td>
<td>36</td>
</tr>
<tr>
<td>Index mode printing</td>
<td>83</td>
</tr>
<tr>
<td>Index screen</td>
<td>29</td>
</tr>
<tr>
<td>Indicator</td>
<td>12</td>
</tr>
<tr>
<td>Initialize</td>
<td>58</td>
</tr>
<tr>
<td>Install</td>
<td>65</td>
</tr>
<tr>
<td>Internal memory</td>
<td>17</td>
</tr>
<tr>
<td>Internal Memory Tool</td>
<td>54</td>
</tr>
<tr>
<td>Interval</td>
<td>41</td>
</tr>
<tr>
<td>ISO</td>
<td>7, 37</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>J</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPG</td>
<td>72</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landscape mode</td>
<td>26</td>
</tr>
</tbody>
</table>
Index

Language...............................58
LCD Backlight........................58
LCD Screen ..........................16

M
M AF.....................................51
Macintosh computer .............80
Recommended environment ......80
Macro....................................21
Map View .............................77
Mass Storage.........................59
“Memory Stick Duo”.........104
Memory Stick Tool...............55
Menu.....................................30
   Items ..................................31
   Shooting................................32
   Viewing ................................43
Metering Mode .....................35
Mode ....................................39
Monitor .................................51
MPG .....................................72
Multi AF.................................33
Multi Burst..............................39
Multi connector......................11
Multi-pattern metering ..........35
Multipoint AF .......................33

N
Natural ..................................32
NR slow shutter ....................13
NTSC .....................................60

O
Optical zoom.....................20, 51
OS .....................................64, 80
Overexposure .......................7

P
P.Quality ...............................38
PAL ........................................60
PC .........................................63
PictBridge .........................59, 83
Picture Motion Browser .......74
Pixel .......................................9
Playback ...............................28
Playback zoom ......................28
Precision digital zoom ..........51
Pressing halfway down ........6
Print .......................................82
   Index mode ..........................83
   Single-image mode ..............83
Print order mark .................87
Printing at a shop ................87
Printing directly ..................83
Program Auto mode ...............18
Protect ....................................43
PTP .........................................59

R
REC Mode ...............................39
Red Eye Reduction ...............52
Resize .....................................46
Rewind/Fast forward .............28
Rich .......................................32
Rotate ....................................47

S
S AF .......................................51
Scene Selection .....................25
Screen
   Changing the display ..........16
   Indicator ............................12
   LCD backlight ....................16, 58
Self-diagnosis display ..........100
Self-timer ..............................22
Sepia ....................................32
Setup .................................42, 49, 50
   Camera ................................51
   Internal Memory Tool ..........54
   Memory Stick Tool ..............55
   Setup 1 ..............................58
   Setup 2 ..............................59
   Setup 1 ...............................58
   Setup 2 ...............................59
   Sharpness ..........................42
Shooting
   Movie .................................19
   Still image ............................19
   Shooting menu ......................32
   Shooting movies ...................18
   Shutter speed ........................7
   Single ..................................51
   Single-image mode printing ....83
   Slide Show ............................45
   Slow synchro .........................21
   Smart zoom ...........................51
   Snow mode ...........................26
   Soft Snap mode ......................26
   Software .............................65, 74
   Spot metering .........................35
   Spot metering cross hairs ......35
   Standard .............................38

T
Trimming ...............................49
Troubleshooting ......................89
TV ........................................61
Twilight mode .......................26
Twilight Portrait mode ..........26

U
Underexposure .......................7
USB cable .............................67, 84
USB Connect ..........................59
Index

V
VGA ..................................... 24
Video Out ............................. 60
Viewing menu ...................... 43
Volume ................................. 28

W
Warning indicators and messages.............. 100
WB........................................ 36
White balance ....................... 36
Windows computer............... 63
  Recommended environment.......... 64
Write-protect switch .......... 104

Z
Zoom .................................... 20
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/